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Abstract

This thesis describes a program of study for a master’s degree in network and
system administration in Pakistan. It describes the course sequence and the
individual courses that will be taught. It also discusses the facilities and computing
resources required. It proposes a lab environment based on the Raspberry Pi
device and Xen-based virtualization for student work, using the MLN tool for
management. Some usability tests for the suggested lab environment were
performed and indicated that it would be suitable.
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Chapter 1

Introduction and problem statement

Formal studies of computer networks and system administration are urgently
needed today because the infrastructure of computing resources is growing
rapidly, resulting in increasing complexity of management. For this reason, many
developed countries have already initiated programs of study where many
talented students graduate every year to provide the technical workers need in
that country. There is a great need for such modern programs of study in
Pakistan as well, but there are not currently any available. This thesis focuses on
initiating such a program of study in Pakistan.

1.1 INTRODUCTION AND MOTIVATION

Computer networks and systems offering different services are getting more and
more congested as the infrastructure expands over the time within organizations.
There is a need felt amongst the developed countries to regularize a scheme of
study that will satisfy the challenges in the future related to Network and System
Administration. Therefore a systematic approach has been adopted to fulfill this
need by educational institutes in many countties, including the USA, Norway,
Australia and the Netherlands. There is a need to develop such educational
programs in Pakistan as well.

1.1.1 EDUCATIONAL EXPERIENCE AND INTERESTS

I will begin with a summary of my own educational background. I completed my
undergraduate studies in computer science in Pakistan. These gave me a good
sense of the general level of computer education in Pakistan. I discovered I have
a natural aptitude for networks and system administration during my
undergraduate studies. My interest in networks leaded me to write an
undergraduate diploma thesis about the OSPF routing protocol.
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I studied at a private institute named Corvit Systems, situated in Lahore,
Pakistan. Corvit Systems is known as one of the best institutes in Pakistan
regarding network and system administration studies. It charges very high tuition
fees. I learned many skills there and had a feeling that I knew enough to work as
professional.

Eventually, I travelled to Norway. There, I availed myself of the opportunity
to study at Oslo University/Oslo and Akershus University College of Applied
Sciences (OAUC) in the network and system administration mastet’s degree
program. I quickly found that the level of technical instruction was much higher
in Norway than I had seen in Pakistan. The program at OAUC is also much
more systematic and comprehensive than the existing programs in Pakistan. In
fact, unfortunately, there is no institution in Pakistan where one can learn

technical skills in such a comprehensive way as I learned being a student at
OAUC.

In Pakistan, there are different private institutes offering some certification
programs regarding Network and System Administration but the density of the
courses taught and the lab environment given to students does not meet the
systematic approach to cover this program of study. This master thesis will focus
developing such a systematic approach to introduce the said scheme of study in
Pakistan and will provide as complete a plan for implementing it as possible. All
the required tools, technologies, configuration, management of resources and

course structure will be discussed in detail.

Teaching is another natural aptitude that I inherited from my father and
grandfather. I started teaching during undergraduate studies in one of the schools
under the ownership of my father. After undergraduate studies, I taught in the
Government College in Abbottabad, Pakistan. I also had an opportunity to work
as a student assistant for the first year master’s degree students in system security
course at OAUC. I hope to use this ability in a network and system
administration course in Pakistan.

1.1.2 TECHNICAL EDUCATION IN PAKISTAN

Educational institutes in Pakistan fail to produce good quality professionals in the
field of network and system administration. The main problem for institutes in
Pakistan is a lack of technical people who can manage such programs of studies.
There are already well reputed universities and colleges exist in Pakistan where
international students from neighboring countries also come for their higher
education. There is lot of development seen in the field of IT and many
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educational institute offers high quality of education in the field of computer

science.

However, there is no formal education in Network and System
Administration for local or international students. Although there are highly
educated people from well reputed institutes in the world in many fields, there
are very few specifically in network and system administration because such
schemes of study are too young in the world. Currently students from different
educational institutes complete their programs with quite minimum level of skills
and professionalism. Thus, Pakistan lacks people who can manage and
implement study programs to produce good quality network and system
administrators.

If we observe the relevant job market, we will come to know that many
companies acquire IT professional services from foreign companies, costing huge
amounts of money, because Pakistan lacks technical people. There is need for an
educational team aware of and interested in network and system administration.
They need proper training, education, skills and vision to initiate master level
studies in network and system administration.

1.1.3 GOINGABROAD IS NOT ALWAYS POSSIBLE

Because there is little scholarship support or other financial aid for students from
the government in Pakistan, it is not possible for everyone to travel abroad to
existing programs in network and system administration. While financial
problems are the main reason why many students cannot study abroad in existing
programs, there are number of other obstacles as well. There are strict admission
processes abroad in well reputed universities in admitting students; thus, many
students also fail to gain a seat in a degree program. Obtaining a visa for nationals
of developing counttries is also quite challenging, and everyone doesn’t succeed.

Some students manage to get a visa, and they travel for studies as self-
financed students with the intention of managing their expenses with part time
jobs. This can result in frustration if part time work is not available. Working can
also be an obstruction to succeeding at their studies if one cannot give the
necessary time to studies as it deserves. Thus, many international students face
significant problems in studying abroad.

Considerations like these have motivated me to create a network and system
administration program in Pakistan to serve local students, as well as ones from
nearby countries, and to prepare them to be the high quality computer
professionals that industry needs.
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1.2 PROBLEM STATEMENT

How can a program of study for Network and System Administration be created
and implemented in Pakistan? This thesis will consider these questions:

e What is course structure for the said studies?

e How can a lab environment be set up given the technical capabilities and
challenges of Pakistan? What tools and technologies are appropriate? What
software and hardware can be used? Are low cost hardware solutions
adequate to this task?

e What are the other requirements for such a program, including facilities and
cost?

I have had a good experience while studying in the master’s degree program in
Network and System Administration at University of Oslo/OAUC. Using this
experience, I will focus on importance of such studies in Pakistan, which is
geographically situated in the heart of many developing countries in south Asia,
the Middle East and central Asia.

I will examine the Raspberry Pi as a potential component of the program. It
is a relatively new, low cost hardware solution which may greatly reduce the
startup cost required for such a program of study.



Chapter 2

Background

This chapter discusses several topics which are important background

information for this thesis.

21

It is important to understand the technical infrastructure of the private and
government sectors in Pakistan, as well as available human resources to
manage that infrastructure.

There are different countries offering Network and System Administration
degree courses in various parts of the world. Those existing post-graduate
programs in Network and System Administration are important to bring into
focus while suggesting a similar type of studies in Pakistan. The admission
requirements, courses, degree requirements and study duration are important
aspects to consider for this thesis.

Virtualization will be an important technique for network and system
administration. Thus, it is important to have a glance over virtualization and
education in Pakistan. What are the techniques, technologies and tools to
manage virtualization for study purposes? This thesis will focus on a software
tool known as MLN. There are other ways to create virtual machines but this
tool makes it quite easy and fast to create virtual machines and manage them.

The Raspberry Pi is a new small credit card size computer developed in the
UK by the Raspberry Pi Foundation. It runs the Arch Linux and Debian
Linux operating system distributions. It is designed to be capable of
performing different tasks for education purpose with minimum cost.

NEED FOR NSA PROFESSIONALS IN PAKISTAN

In Pakistan’s major cities, there is good job market for Network and System

Administration professionals. There is such a shortage of propetly trained people

that private companies often have to hire people without proper skills and then

train them according to their needs. In another common scenario, companies
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purchase services from international companies as the quality of services within
the country offered are quite a bit below the high standards around the world.

For example, a well-known media company, the Jang group, contracted for
IT services from the international company ZEN Network Technologies, Ltd. (9
Devonshire Square, London EC2M 4YF United Kingdom). When one of its
servers is probed on port 80, it shows that the company does not have its own
infrastructure to meet its service requirements. Below is traffic information
captured using tcpdump when port 80 is contacted with multiple requests using a
Perl script.

1 06:44:40.123346 IP 192.168.1.2.34045 > 194-28-157-30.zen
protection.com.http:Flags [.], ack 105997, win 9659, length 0
2 06:44:40.128644 IP 194-28-157-30.zenprotection.com.http >

192.168.1.2.34045:Flags [.], seq 105997:107449, ack 117, win
46, length 1452

3 06:44:40.128753 IP 192.168.1.2.34045 > 194-28-157-30.zen
protection.com.http:Flags [.], ack 107449, win 10024, length 0
4 06:44:40.133827 IP 194-28-157-30.zenprotection.com.http >

192.168.1.2.34045:Flags [.], seq 107449:108901, ack 117, win
46, length 1452

5 06:44:40.133950 IP 192.168.1.2.34045 > 194-28-157-30.zen
protection.com.http:Flags [.], ack 108901, win 10389, length 0

There are other multinational companies seeking significant numbers of
skilled professionals throughout the year. Even educational institutes lack highly
skilled professionals who can manage their own network infrastructures.

2.2 TECHNICAL EDUCATION IN PAKISTAN

Technical education, by its nature, has to be significant to other sectors of society
in order to educate and train the technical human resources needed for socio-
economic development. Nowadays, society is rapidly changing, and it is essential
for technical education to strength its linkage with the changing requirements of
the work place.

Being a part of educational system and a citizen of Pakistan, I have
undertaken computer studies in a well reputed institute whose program is quite
similar to many other institutes. I also visited and surveyed three different
educational institutes in the well-developed city of Abbottabad: Government
Post Graduate College (Mandian, Abbottabad), COMSATSs Institute of
Information Technology (Abbottabad) and Hazara University (Abbottabad). In
all of these institutions, there are few computing resources allocated for the
students. There are systems which handle student’s accounts and credentials, but
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there are very few or no computers which give opportunities to students to use
them so that they can learn by performing lab tasks so that they can get a feel for

real scenarios.

Most of the schools, colleges and universities in Pakistan have not yet
transferred from the traditional use of paper to digital world of computing. There
are a few trained technical people, but their number is negligible compared to the
needs of the expanding technical infrastructure of Pakistan. Most technical
people are hired by private or foreign companies as they are not employed within
country’s public sector because of incompetence in government. Therefore it is
felt the need of proper human and educational resources so that Pakistan can
build its technical infrastructure in its true essence.

The main reason for this shortage is that advanced education in network and
system administration are unavailable in the country’s educational institutes.
There is no research and development program for such studies. Students
interested in network and system administration studies cannot receive
instruction as there are not skilled people who can arrange proper infrastructure
for them. For example, COMSAT: Institute of Information Technology, which
resembles other institutes in the country, lacks the proper infrastructure for
master’s degree level studies. Students are given negligible resources compared to
what they need.

Figure 2.1. COMSATS Institute of Information Technology (Abbottabad)

10



TECHNICAL EDUCATION IN PAKISTAN

Figure 2.2 shows the R&D (Research and Development) Lab, which is the
only place where master’s degree students have opportunity to do research and
development in the field of IT. The lab is comprised of fewer than 10 P4-based
computers running Windows XP installed. The only allowed connection is on
port 80.

Figure 2.2. R&D Lab at COMSATS Institute of Information Technology
(Abbottabad)

There are many IT and computer studies institutes in the country, but none
of them offer post-graduate study in Network and System Administration. There
is one college found, Pakistan Navy Engineering College, which offers some
network and system administration diploma courses, but these are very limited
and only at introductory level. They also do not use any open source tools and
technologies. Figure 2.3 shows the course contents offered at this institute in
Pakistan.

There are other private institutes offering similar courses, but they again are
without deep knowledge or quality of studies. Many institutes also have vested
interests with companies like Microsoft and Cisco. They only offer courses which
in reality have nothing to do with becoming highly skilled in the field of network
and system administration. Their main focus is to introduce some of the
company’s proprietary tools and enable the students to pass their certification
examinations, by any means available. For example, CCNA, CCNP and MCSE

11
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related-courses are taught at introductory level, and later on students are given
dumps of previous exams to pass the exams by mean of cheating [2]. This is why
Pakistan has produced the youngest Microsoft certified professional, a 9-year old
named girl Arfa Karim [3].

Advance A+ certification

(Preparation Course)

At PNS JAUHAR, courses are conducted by
foliowing the CompTIA’s international exam
syllabus and faculty ensures that training quality
meets the international standards.

After Completion of A+ Certification Course
(IT Essential & IT Technician)

@ One can maintain, repair and troubleshoot
computer Hardware (Processor, Motherboard,
All components) printers, networks and the
intemet

@« One can operate windows xp, vista, 07
® One can work as System Support Professional

® One can go abroad and apply for job &
this program has worldwide recognition.
This program has high demand in USA,
Canada and Australia

e Best of all our local industry has also high
demand of the A+ Certified professionals

® One can appear in international examination
of CompTIA USA

Pakistan Navy Engineering College
PNS JAUHAR OFFERS FOLLOWING COURSES

Networks & System
Administration

Network's theoretical concepts. Deployment
of Enterprise windows server 2008
configuration, management and maintenance.
Domain controller and Active Directory
overview. TCP/IP protocols following server's
deployment and configuration: (DHCP, Print
server, DNS, 1IS, GROUP POLICY, SERVER)
Symantec end point protection update and
scanning Wireless network WiFi Microsoft
Backup and third party Software utilities.
VMWare virtual implementation Windows 07
as client setup. Network resources share Disk
quotas Cabling (cross, straight) WAN, LAN,
WLAN, OSI Modes, Multi Layer Switching,
Configuration of routers |10S & Manageable
Switches & WAN included such as frame
Relay, VPN, 802.1q & Network Security
treatments & Network System Server
Administration includes Windows 2008, ISA
Server 2004, GPO Server, IIS Server 6.0,
NTFS 5.5 DNS Server 2008, DHCP Server
2008, complete implementation. Client sites
windows 07. Deployment and intro of ISA
2004/2006 Cashing Rules and Restriction
Type of ISA clients Web chaining Monitoring
Server publishing Site to site ISA backup and
restore. Routers and catalyst switches features
Switching and routing Access List and Network
Address Translation and IPv6.

FOR MORE INFORMATION

Pakistan Nawv Engneeri College, Karachi
Tel (021) 48503070 & 48503044

Web: www.pnec.nust.edu.pk/ipdc.htmi

L Email Address: info_pdc@pnec.edu.pk

& ©

R
Figure 2.3. Courses offered at one of the institutes in Pakistan

[T »

It is quite clear from the above information that Pakistan lacks the skilled
people and systematic studies required to excel in the field of IT. Pakistan needs
good quality of network and system administration professionals to meet its need
in the coming future according to the adopted standards of the developed
countries [1].

12



TECHNICAL EDUCATION IN PAKISTAN

2.21 CURRENT GRADUATE PROGRAMS IN COMPUTER
SCIENCE IN PAKISTAN

The Higher Education Commission (HEC) of Pakistan ranks universities by
field. The ranking is based on many factors, including the number of students,
research productivity and quality, innovation and knowledge transfer,
infrastructure, and others [4]. The following were the top 5 computer studies
institutes in Pakistan that offered master’s degrees in computer science and
computer science courses as part of master’s degrees in related disciplines.

e COMSAT Institute of Information Technology, Islamabad

Master of Science in Computer Science
Master of Science in Health Informatics
Master of Science in Electrical Engineering

O O O O

Master of Science in Mathematics

e National University of Computer and Emerging Sciences, Islamabad

MS Computer Science
MS Computer Networks
MS Mathematical Sciences

O O O O

MS Electrical Engineering

e Qurtaba University of Science and Information Technology, D I Khan

o MS Computer Science
o MS Mathematical Sciences

¢  Quaid-i-Azam University, Islamabad

o MPhil Computer Science Program
o MS Information Science and Technology
o  M.Sc. Computer Science Program

® City University, Peshawar
o MS Computer Science

Master’s degree computer sciences courses taught in the top five universities
of Pakistan are listed below organized into general categories.

13
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Programming: programming languages are mainly C, C++, C# and .NET.

O

O 0O 0O O O

Problem solving and Programming

Object Oriented Programming

Comparative Study of Programming Languages
Theory of Programming

Theory of Programming Languages

Design and Analysis of Programming languages

Software engineering: generally taught from an abstract point of view, separate

from actual programming.

(e}

O 0O 00O 0O OO O0OO0OO0OO0OO0OO0

Rapid Application Development
Introduction to Software Engineering
Software Engineering

Software Testing Techniques

Emerging Trends in Software Development
Software Entrepreneurship

Software Project Management

Advanced Software Engineering

Software Quality Assurance and Testing
Disciplined Software Processes

Knowledge Management for Software Engineering
Software Management & Economics
Software Architectures

Software Patterns

Databases and data management: the former is mostly focused on relational

databases and SQL.
o Database Design
o Information Retrieval Systems
o Data Mining
o Data Warehousing

Architecture, algorithms and related topics: also typically taught as lecture

only, without any practical applications.

(e}

O 0O 0O 0O O 0 O

Computer Systems

Computer Architecture

Data Structures and Algorithms
Introduction to Computing Theory
Operating Systems

Analysis and Design of Algorithms
Compiling Techniques

Advanced Analysis of Algorithms

14
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o Advanced Operating Systems
o Theory of Computation
o Advanced Computer Architecture

Human-Computer interaction: theories of usability, benefits of computing to
humans, computing uses in various environments.
o Human Aspects of Computing
o Human Computer Interaction
o Advanced Human-Computer Interaction
o HCI Models and Theories
o Design for Usability
Artificial Intelligence and related topics
o Artificial Intelligence
o Expert Systems
o Neural Networks
o Machine Learning
o Pattern Recognition

Information theory
o Theory of Automata
o Discrete System Simulation
o Information Theory
o Information Systems

Multimedia and web computing

o Computer Graphics
Multimedia Applications and Design
Electronic Documents
Web Technologies
Web Engineering
Introduction to Semantic Web
Multimedia Technology
World Wide Web and Society
Semantic Web
Digital Libraries
Modeling of Web Information Systems
Multimedia Retrieval Techniques
Metadata for Information Resources
Information Privacy and Access Control

O 0O 00O 0O O0OO0OO0OO0OO0OO0OO0OO0O0

Multimedia Communications

15



TECHNICAL EDUCATION IN PAKISTAN

Information Technology and enterprise computing
o Computer Communications and Networks

Enterprise Information Infrastructure

Social Issues in Information Technology

Computing Case Studies

Requirements Engineering

Distributed Systems

O 0O 0O 0O 0O O

Enterprise Architecture

Miscellaneous courses

o Mobile Computing Systems
Real Time Systems
Concurrent Programming
Research Methods
Data Compression
Grid Computing
Peer-To-Peer Systems

0O 0O 00O 0O 0 O

Ubiquitous Information Interaction

If we go through the courses taught in universities of Pakistan then we will
come to know that there are no formal studies in the field of networks and
system administration. We also notice that there is very little emphasis on
networking and only limited offerings in enterprise computing and infrastructure

management.

2.2.2 POTENTIAL STUDENTS FOR NSA GRADUATE STUDY IN
PAKISTAN

The number of undergraduate college students in Pakistan in not an easy statistic
to access, but it is estimated to be over 1,000,000 including both academic
institutions and professional schools [5]. So a mere lack of potential students is
not a problem in initiating a network and system administration master program.
But what sort of students is suited to these studies?

Network and system administration studies require a good understanding of
computer science. A student with a baccalaureate (or equivalent) degree from an
accredited institution in computer science, IT, computer engineering or
electronics engineering has good potential to succeed with this degree. There will
be need of hard work and a good understanding of basics of networks and
system administration. Therefore, it is important to evaluate students by use of
different means to determine whether he/she can carry on with such studies.
Previous educational records give quite good information to evaluate the
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student’s caliber, and he/she should have a minimum cumulative grade point
average of 3.0 or 70%. Students wishing to study NSA program must have a
good educational or working record in networking and in systems administration.
If a student does not have the necessary background, extra courses will be
required to help students to meet the prerequisites.

2.3 EXISTING NSA POST-GRADUATE PROGRAMS

It is always good to analyze the experience of others while initiating a new thing.
As mentioned earlier, NSA studies are already taught in numbers of institutes and
universities worldwide. Therefore, it is important to know how they recruit new
students, what criteria they use in the admission process, how the curriculum is
structured and how long it takes to complete the degree program. In this way,
one can sort out the overall program structure. This section summarizes the

different NSA programs now available.

Previous surveys such as this were performed in 2007 by Burgess and
Koymans [6] and by Kacoroski and Tsalolikhin in 2012 [7]. The first work
desctibed the programs then in place at the University of Oslo/Oslo University
College and the University of Amsterdam. Both of these programs are included
in the list in this thesis.

Kacoroksi and Tsalolikhin identified 7 universities offering programs in
network and system administration. Of these, 2 were master’s degree programs:
University of Oslo/Oslo and Akershus University College of Applied Sciences
and Florida State University.

At this time, the following universities offer post-graduate programs in
network and system administration:

e Florida State University (USA)

e University of Oslo/Oslo and Akershus University College of Applied
Sciences (Norway)

e University of Amsterdam (The Netherlands)

e Rochester Institute of Technology (USA)

e Charles Sturt University (Australia)

2.3.1 FLORIDA STATE UNIVERSITY (USA)

Florida State University is located in Talahassee, Florida, USA. It offers an MS
degree in Computer Network and System Administration (CSNA) [8]. It focuses
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on practical system administration. For example, this degree program requires
system administration experience to complete it. The university provides
assistance for students in getting an internship.

Admission requirements: Undergraduate degree with GPA 3.0 or better, GRE
score of at least 1000 (verbal+quantitative), system administration internship(s)

Prerequisites: Undergraduate courses required (can be completed during the
master’s degree program in some cases, but not for credit):

Computer Organization I
Computer Organization II
Data Structures, Algorithms and Generic Programming

O O O O

Operating Systems and Concurrent Programming
Courses required for MS CNSA Degree Program:

Computer Architecture

Network Security, Active and Passive Defenses
Data and Computer Communications

Computer and Network Administration

Advanced Operating Systems

Concurrent, Parallel, and Distributed Programming

O O 0O 0O 0O 0 O

6 more courses

Additional requirements: Students have a choice of a thesis (equivalent to 3
courses), a project (equivalent to 2 courses) or a courses-only track. An internship

or other experience is also required.

Program length: 12 courses over 2 years
2.3.2 UNIVERSITY OF OSLO/OAUC (NORWAY)

The University of Oslo collaborates with Oslo and Akershus University College
of Applied Sciences to teach the Master’s in Network and System Administration
degree program in Oslo, Norway. Most of the courses are designed and taught by
OAUC. I have been a student in the said degree program. This program gives a
deep vision of theory, principles and practical issues related to network and
system administration. This program focuses on network, system design, analysis,
efficiency and security. Most of the course is based on practical skills in UNIX
platforms along with the taste of windows and Macintosh platforms. Most of the
tasks are practical lab work where students perform in their projects. The degree
program consist of such courses which are current trends in the I'T industry such
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as general system administration, networking, security, information infrastructure
and analytical methods to solve problems related to network and system
administration.

Admission requirements: Undergraduate degree with at least a C average.

Prerequisites: Degree in Informatics or 80 ECTs in Informatics including
Operating Systems, 20 ECTs in programming and 10 ECTs in Mathematics

Courses required for the Master’s degree in NSA:

Year | Semester 1 Semester 2
1 | Intrusion detection and firewalls | Network and system admin. 2
Networking technologies and Research paper
principles Cyberethics
Network and system admin. 1 Elective

2 | Analytic system administration Thesis
and project methodology

Network infrastructure and
security lab

Elective

Program Length: 2 years
2.3.3 UNIVERSITY OF AMSTERDAM (THE NETHERLANDS)

The master’s degree program in network and system administration at the
University of Amsterdam in Amsterdam, The Netherlands has two separate
tracks: networking and forensics [10]. Both are full time studies comprised of one
year and part time studies comprised of two years. The academic year has two
semesters, ecach composed of three 4-week blocks.

The program’s website states the following objectives for the program:

To train system and network engineers that are: at an
abstract level knowledge of the operation of computer
systems and networks in terms of interfaces and
protocols; capable of translating that abstract level into
concrete systems and network configurations, regardless
of the vendor of the underlying systems; capable of
obtaining new knowledge about innovations and their
potential; able to integrate new technology in an
evolutionary manner to an existing situation; able to
integrate new technology in an evolutionary manner to an
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existing situation; familiar with the ideas of the Open
Source movement and can distinguish between
advantages and disadvantages compared to proprietary
technology; and able to identify security aspects of
systems and networks and if necessary adapt them [10].

Admission requirements/Prerequisites: Undergraduate degree in computer
science or a degree in informatics or a related field and passing an assessment on
general knowledge (mathematics, reading, writing and presentation) and on basic
knowledge of Linux/UNIX, networking and shell scripting.

Courses required for the Master’s degree in NSA, Networking track:

Block | Semester 1 Semester 2
A Classical Internet Applications InterNetworking and Routing
Essential Skills Large Installation Administration
B Distributed Internet Applications | Offensive Technologies
Security of Systems and Networks | Advanced Networking
C Research Project 1 Networking Research Project 2

Courses required for the Master’s degree in NSA, Forensics track:

Block | Semester 1 Semester 2
A Classical Internet Applications Cybercrime and Forensics
Essential Skills Large Installation Administration
B Distributed Internet Applications | Offensive Technologies
Security of Systems and Networks | Visual Analytics
C Research Project 1 Forensics Research Project 2

Additional requirements: 2 projects including a report and presentation.
Program Length: 1 year
2.3.4 ROCHESTERINSTITUTE OF TECHNOLOGY (USA)

Rochester Institute of Technology is located in Rochester, NY (USA). This
program states that its goal is to “make students capable of availing such
technical skill which makes them leaders in a modern IT industry. The main
focus of this degree program is to give students technical knowledge and
concepts that any business required while implementing solutions to help that
business” [11]. This program is available both on-campus and as distance
learning.

Admission requirements: Undergraduate degree with at least a 3.0 (B) average.
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Prerequisites: C++ computer programming, networking and system
administration theory and practice, and statistics.

Courses required for the MS degree in NSA [12]:

Year | Semester 1 Semester 2
1 | Research Methods and Proposal | 2 core courses
Development Elective

Enterprise Computing
Core coutse

2 2 cote courses 2 Electives

Elective Capstone: Thesis or Project

Core courses are:

o Organization behavior and leadership
Project management
Secured wireless and wired networks
Emerging network technologies
Enterprise security

O O O O O©°

Network design and performance
Program Length: 2 years
2.3.5 CHARLES STURT UNIVERSITY (AUSTRALIA)

Charles Sturt University (CSU), in Wagga Wagga, NSW, Australia, offers the
Master of Networking and Systems Administration to students who want to have
high rank positions in the field of network and system administration [13]. The
website states that the program is developed with close consultation with the IT
industry so that it can provide a study scheme which allows successful students
to have full grasp over of designing, implementation, troubleshooting and
managing computer systems and networks. It further states that “CSU’s Master
of Networking and Systems Administration incorporate preparation for the
wortld’s most popular industry certifications from major IT vendors including
Cisco and Microsoft.” The program has 5 tracks: Microsoft Networking, Cisco,
Linux, Microsoft Database Administrator and Oracle.

This program is offered only as distance learning. There is no on-campus
option. The academic year is divided into three sessions.

Admissions requirements: Undergraduate degree.

Prerequisites: None
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Courses required for the master’s degree in NSA, Linux track:

Session | Year 1 Year 2
1 Networking Concepts 1 Core subject
Linux elective Linux elective
2 Networking Concepts 2 Core subject
Linux elective Linux elective
3 Core subject Topics in I'T Ethics
Linux elective Linux elective

Core courses are chosen from:
o Wireless Networking Concepts
Information Systems Strategy
IT Management Issues
Network Security
IT Risk Management
Network and Security Administration
Digital Forensics

0O 0O 0O 0O OO

Linux electives are chosen from:
o Forensic Investigation
Hacking Countermeasures
Hardware and Software Essentials
Linux Fundamentals
Linux Administration
Managing Linux Enterprise Servers
Linux Enterprise Security
Novell Administration
Managing Desktop Resources
IT Service Release, Control and Validation
IT Service Operational Support and Analysis
IT Infrastructure Library Foundation
Project Management Fundamentals
The Project Lifecycle
Enterprise Project Management

0O 0O 0O 0O 0O OO O0OO0OO0OO0OO0OO0O O0OO0

Developing Solutions
Program Length: 2 years

2.3.6 SUMMARY AND COMPARISON

The following tables summarize the key facts for these graduate programs in
network and system administration. The first table lists the basic information
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about each program while the second table indicates the topics covered in the

program’s core curriculum.

FSU UO/OAUC | UA RIT CsuU
Length 2 years 2 years 1 year 2 years 2 years
# Semester 12 12 6 12 12
courses
Thesis/project | optional | thesis 4 projects | thesis or | none

project

Campus or campus | campus campus both distance
distance
learning
Internship yes no no optional | no

The following table lists the core curriculum dedicated course work by
subject area:

ou/
Area FSU | OAUC | UA | RIT | CSU
General System Admin . . . .
Advanced Networking . . . . .
Computer Architecture .
Scripting/Programming . .
Security . . . . .
Web-based Services .
Vendor-specific topics .
Research . . . .

2.4 USEFUL TECHNOLOGIES FORNSA EDUCATION

This section provides a very brief overview of some technologies which will be
useful to the proposed master’s degree program.

2.41 VIRTUALIZATION AND EDUCATION

Virtualization technology is one of the most active topics in the field of
computing industry today. Many people associated with I'T industry want to take
advantage of benefits offered by virtualization technology to create easy and low
cost solutions for their organization, whether it is an educational institute,
government uset, or a private company. In education, virtualization has made it
quite easy to allocate resources to students in an efficient way for their research
and development studies.
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Virtualization consists of using software and hardware to create virtual
machines (VMs). Using virtualization, one can make several virtual machines on a
single computer which share hardware resources and act like completely
independent machines.

The hypervisor, also known as the virtual machine manager, is the tool that
allows different operating systems to be installed on a single computer/host for
the sake of sharing hardware resources. Each operating system behaves
independently because the hypervisor keeps its assigned resources, such as
memory, processor, storage and so on, separate from the other VMs. The
hypervisor manages the processor and other resources so that VMs do not
disrupt each other.

Virtualization gives a number of benefits to any organization [14]. Some of
them are listed below:

e Simplifies the data center.

e (Can create lab environments for the students.

e Uptime is quite improved.

e Low cost and environment friendly.

e Requires less space.

e Improvement in backup and disaster recovery.

e Tacilitate older applications dependent on OS or hardware.
e Make your own cloud.

e [Efficient system management.

e Physical Platform independence.

Virtualization has an important role in today’s education. Use of
virtualization for the sake of education is excellent as it gives number of benefits.
Therefore most of the universities, colleges, schools and different organizations
in developed countries have already implemented virtualization technology in
their infrastructure. Some of the benefits to education are listed below [14]:

e Ensures the same type of environment for all students.

e VNMs are accessible from anywhere.

® Access resources from various platforms using different hypervisors.
e Seccurity is well handled.

e [Efficient usage and management of tools, installation and management.

Virtualization will play a large part in the master’s program described in this
thesis.
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242 MLN

MLN (Manage Large Networks) is a program written in Per]l to create a
comprehensive network of Xen, User Mode Linux or other virtualized systems
by using a simple configuration file [15]. It creates virtual machine on demand
and automatically and makes configuration and management simple. MLN uses
an easy programming language to create different configurations for different
purposes. MLN offers commands that allow creation, starting and stopping, and
termination of a virtual machine quickly. MLLN also provides virtual networks,
and those networks can be connected with each other if desired to make a larger
network.

2.4.3 RASPBERRY PI HARDWARE

The Raspberry Pi is a small credit card sized, single-board computer developed
by computer a United Kingdom (UK) charitable organization called the
Raspberry Pi Foundation for computer science education [16]. It is illustrated in
Figure 2.4.

The Raspberry Pi computer comes in two versions:

e Model A, costing $25 (USD), has 256MB RAM and one USB port but no

network connection.

e Model B, costing $35-$40 (USD), has 512MB RAM, and comes with two
USB ports which can be used, for example, for a keyboard and mouse. It has
also a network interface card and can be connected to an Ethernet network.

Kits containing cases and external connectors as well as the boatd itself are
also available [17]; some kits also contain electronic components (for example,
breadboard and jumper wires) for hardware prototyping. The cost for the latter
type of kit is about $120 (USD).

The Raspberry Pi runs a version of the Linux operating system. The
Raspberry Pi has been used for many different purposes, some are listed below:

e Simple network storage.
e Media center control.
e Remote control of PCs.

¢ Low cost Linux computer.

The Raspberry Pi device potentially offers a very low cost way to provide
workstations for students in combination with virtualized systems.
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Figure 2.4 shows the Raspberry Pi computer. The board is shown at the top.
The illustration on the bottom shows it in a case and in use as a workstation as a
test system for this thesis.

Figure 2.4. The Raspberry Pi computer
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Chapter 3

Curriculum

The proposed Masters of Networking and System Administration degree
program gives students such skills that allow them to configure and manage
different computer networks in a systematic way. It gives students deep
knowledge and technical skills that make them capable of handling complex
computer network systems. The curriculum for this master’s level program is
flexible because of technological updates and fast rate of change in the market.
Topics of the curriculum can be delivered through lectures initially and later on
must be experienced practically in a lab environment using resources that give
students real life example scenarios. Successful graduates can obtain jobs in many
fields related to network and system administration. This includes system ot
network administrator, security analyst, and computer consultant. Detailed
descriptions of the curriculum and courses are given in this chapter.

3.1 MISSION STATEMENT

With this program, graduate-level network and system administration education
is offered for the first time in Pakistan. The program offers comprehensive,
hands-on experience in installing, configuring and administering the large
networks and systems used in the world today. This program is much more
systematic and comprehensive than existing programs in Pakistan in the field of
network and system Administration, whether in the public or the private sector.

A research based studies of NSA make this course so efficient that students
can make different new projects, tools, benchmarking etc. and the course can
lead to doctorate level studies as well. Beside this a student while doing Master
not only propetly acquiring knowledge but also getting ready to work in IT
industry according to the current trends as a computer architects, system
administrators, policy implementers, technical managers, network engineers, IT
consultants, security specialists etc. Moreover this scheme of study primarily
focuses on developing, adopting and exploring new and easy trends in the field
of network and system administration.
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Automation is primarily taken in to consideration using which one can
automate the comprehensive installations and configurations of systems which is
quite exhaustible if done manually. Using same mechanism of automation new
tools can be developed to help out system administration tasks. This course
offers many options to choose projects and diploma thesis to write needed to

avail a degree.

3.2 ADMISSION REQUIREMENTS & PREREQUISITES

This master’s program will require a bachelor’s degree in Computer Science,
Information Technology or an equivalent field for admission. Students must have
a GPA of at least 60 on the 0-100 scale common in Pakistan (where passing is 50
or higher), which is equivalent to a US GPA of 2.8 or higher. Applicants with

equivalent work experience may also apply.

Students are expected to be proficient in the following skills when they begin
the program:

e Browsing and searching for information on the Internet

e Installing and managing a Windows system

e Software installation under Windows

e Windows client networking setup

e Very basic familiarity with Linux and simple commands. Students without
Linux experience are required to attend an introductory course during the

summer prior to starting the program.

3.3 SEQUENCE OF COURSES

The curriculum will vary from time to time as this is a field of such technology
that updates itself frequently throughout the year, adding and expiring different
technologies. However the most recent technologies of today are the part of
curriculum described here.

The program is designed to be completed in 2 years of full time study,
divided into four semesters. The following table lists the courses and activities in

each of the four semesters:
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Year | Semester 1 Semester 2
1 e Network and system e Network and system
admin. 1 admin. 2
e Intrusion detection and e Scripting
firewalls e FElective
e  Cyberethics
2 e Advanced Networking e Thesis project
e Network infrastructure
and security lab
e Research paper

The first semester contains the easiest and most introductory courses.
Network and system administration 1 provides a broad overview of system
administration under Linux. Intrusion detection and firewalls studies a relatively
easy topic in some depth. This course will be more challenging for the students,
and it will serve as an opportunity for them to evaluate their interest and ability in
network and system administration and to decide if the master’s program is a
good one for them.

The second semester builds on the first. The courses are more difficult and
challenging. Topics are covered in more detail. Scripting is taught at this time as it
will be needed for Network and system administration 2 in the same semestet, as
well as the courses in the second year.

The suggested elective course in the second semester should be chosen based
on the student’s future plans. Those who want to pursue a job after graduation
should select something which will broaden their experience and give them more
skill. This would include courses database administration, web applications and
advanced programming. Students who want to go on to a PhD should select a
research-oriented computer science course such as one on advanced computer

architectures or advanced algorithms.

The third semester focuses on networking in depth. This is a skill that is
needed and sought after in Pakistan, surrounding countries and the Middle East.
The Network infrastructure and security lab course will introduce students of
benchmarking and analysis techniques for hardware, software and
implementation. It will also include information about statistics and experimental
design. The research course will teach students to search for published work on
topics of interest and importance.

The final thesis project can be a research thesis such as those undertaken at
OU/OAUC. Howevet, it can consist of a practical implementation of a tool,
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service or solution to a problem, based on the needs and constraints of a local
environment. The written thesis will be approximately 50-80 pages in length.
Students will give a final presentation on their work.

This program is similar to the one I experienced at UO/OAUC, but some
changes are appropriate for the environment and students in Pakistan:

e Some courses have been moved to different semesters compared to
UO/OAUC. For example, Cyberethics now appears in the first semester.

e Not all courses are the same number of credits. Network and system
administration 1 and the Network infrastructure and security lab are both 15
ECTS.

¢ The Networking technologies course in the first semester at OAUC has been
climinated. Its content has been moved to Network and system
administration 1 and to the new Advanced networking course in semester 3.

e The Analytical system administration course has been eliminated. Some of its
content is incorporated into the Network infrastructure and security lab
course.

e The Scripting course is a required course in this program.

3.4 COURSE DESCRIPTIONS

Courses along with the contents are proposed in the above section. These are the
courses taught in well developed countries of the world with slight differences.
These courses give individuals such technical powers that one can have enough
vision to handle IT infrastructure at enterprise level. Further detail of the courses
and its outcomes are desctribed below.

Notes:

e The “Level” field within each description indicates the level of the course
within this master’s program.

e LBvaluation of students is discussed in detail following the course
descriptions.

e All homework assignments described in the following course descriptions are
mandatory.

3.41 NETWORKAND SYSTEM ADMINISTRATION 1

Basic Information
Name of the course: Network and system administration 1
Level: Elementary
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ECTS-equivalent credits: 15
Semester: 1
Evaluation method: Numeric grades 0-100 (50 is passing)

Target Group

This course, along with the follow-on in the second semester, gives the core
knowledge for the master’s degree in network and system administration
curriculum. It is designed for students who have a basic Linux background and
understand fundamental commands and concepts.

Learning Outcomes
KNOWLEDGE

e Overview of Linux

e Understanding storage (local and network)

e Understanding file systems, including permissions and quotas

e The boot and shutdown processes and their options

e Networking fundamentals: OSI model, hardware, packets, services
e Periodic processes and system logging

e How resources are shared

e Linux users and groups

SKILLS

e Installing Linux

e Starting up and shutting down the system in different scenarios

e Creating and managing user accounts and groups

e Setting up basic networking on a client system, with either static IP addresses
or DHCP. Managing network services.

e Creating and mounting/unmounting local file systems
e Setting file permissions and disk quotas

e Managing network-based storage (SANs and NAS)

e Sharing file system resources with NFS and SAMBA
e Installing and updating software packages

e Using cron to schedule periodic processes

e Hxamining and interpreting system logs

GENERAL QUALIFICATIONS
e C(Capable of performing many system administration functions at a
beginning/junior level
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Organization and working methods
Lectures with demonstrations will be held twice a week. Topics will be divided
into small chunks to aid student learning.

Required course work

Students will have weekly homework assignments, related to the lecture topics
for that week. For example, when DNS is discusses, the assignment might be to
install and configure a DNS server and getting a client system working with that

Server.

Student will submit a short report for each assignment, including any scripts
they have used. Student VMs will also be examined in some cases.

Form of assessment
Assignments 25%
Midterm examination 25%
Final examination 50%

3.42 INTRUSION DETECTION AND FIREWALLS

Basic Information

Name of the coutse: Intrusion detection and firewalls
Level: Elementary

ECTS-equivalent credits: 10

Semester: 1

Evaluation method: Numeric grades 0-100 (50 is passing)

Target Group

This course is designed for first semester students in the network and system
administration master’s program. It assumes that students are familiar with basic
Linux commands and have a general knowledge about the Internet and security
threats.

Learning Outcomes
KNOWLEDGE

e Using firewalls for enterprise network security
e Tirewall architectures

e Stateful packet filtering

e Network address translation (NAT)

e Approaches to intrusion detection

e Signature, protocol and anomaly-based inspection
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e Gathering information and interpreting

e Possible responses to intrusion attempts

SKILLS

e Using the iptables command to configure firewalls and NAT
e Viewing and analyzing network traffic with tcpdump

e Viewing and analyzing network traffic with Wireshark

e Using OSSEC and Snort

GENERAL QUALIFICATIONS

e Ability to configure Linux firewalls for a variety of scenarios

e Ability to select among various IDS/IPS alternatives

e Ability to implement and IDS/IPS system and interpret the resulting data

Organization and working methods
Lectures with demonstrations will be held twice a week.

Required course work
Weekly assignments

Form of assessment
Assignments 25%
Midterm examination 25%
Final examination 50%

3.4.3 CYBERETHICS

Basic Information

Name of the course: Cyberethics

Level: Introductory

ECTS-equivalent credits: 5

Semester: 1

Evaluation method: Numeric grades 0-100 (50 is passing)

Target Group

This course would be appropriate to any student with basic knowledge about

computers and computing. It will focus on situations related to network and

system administration, but the concepts are applicable to many computing

environments.
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Learning Outcomes
KNOWLEDGE

e FDthics and IT

e Standards and philosophies
e Ethics in Islamic context

e Management ethics

e Organizations and ethics

SKILLS
e Familiarity with important codes of ethics

e Ability to analyze situations with regard to ethical concerns

GENERAL QUALIFICATIONS

e An understanding of ethics and their relation to computing

e Basic familiarity with the major ethical issues facing network and system
administrators

e Introduction to the different ethical systems prominent in the world today

e Awareness of ethical standards and issues relevant to working in Pakistan

Organization and working methods
Lectures and discussion once per week. The course will make heavy use of case

studies in order to illustrate and apply the concepts.

Required course work
Reading only.

Form of assessment
Final written exam: 100%

3.44 SYSTEM AND NETWORKADMINISTRATION 2

Basic Information

Name of the course: Network and system administration 2
Level: Intermediate

ECTS-equivalent credits: 10

Semester: 2

Evaluation method: Numeric grades 0-100 (50 is passing)
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Target Group

This course is designed for second semester master’s students in network and
system administration. It assumes knowledge equivalent to Network and system
administration 1. Students must be fully capable of installing, managing and
configuring Linux client systems.

Learning Outcomes
KNOWLEDGE

e Automated system installation

e Configuration management

e The electronic mail system

e Version control systems

e Ticketing systems

e Groupware

e Centralized account management with LDAP

e Virtualization concepts and software

SKILLS
e Configure and implement an automated Linux installation scheme
e Use version control in the context of system administration

e Use a configuration management system to configure and maintain Linux

systems
e Create and manage virtual machines

e Install and configure all aspects of electronic mail: SMTP server, client email
retrieval via POP/IMAP, detect and prevent UBE (spam), scan mail for
viruses, manage mailing lists, administer multiple email domains

e Install and configure centralized authentication for Linux computers using
LDAP, including migrating user accounts

e Management of roaming user accounts, including home directories and
password changing

e Implement heterogeneous authentication for Linux and Windows systems

GENERAL QUALIFICATIONS
e (Capability of managing all aspects of electronic mail using Linux servers

e Ability to set up and manage centralized authentication in a homogeneous

Linux environment and a heterogeneous Windows/Linux environment

Organization and working methods
Lectures with demonstrations will be held once a week.
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Required course work
3 Projects each lasting 1/3 of the semester:

e Project 1: Automatic installation of a Linux system, including configuration
management, version control and an inventory system.

e Project 2: Install an LDAP server including support for centralized user
home directories and secure password changes. Configure electronic mail
system that routes mail propetly, maintains a mail repository from which user
mail can be retrieved and handles multiple email domains.

e Project 3: Implement common authentication for Windows and Linux clients
using Active Directory. Provide resources to all clients.

All work will be done via one or more VMs. These VMs and the student’s
report will be used to evaluate the work.

Form of assessment
Each project will be graded and count for 33% of the final grade.

3.4.5 PERL SCRIPTING FOR SYSTEM ADMINISTRATION

Basic Information

Name of the course: Petl scripting for system administration
Level: Intermediate

ECTS-equivalent credits: 10

Semester: 2

Evaluation method: Numeric grades 0-100 (50 is passing)

Target Group

The course is designed for network and system administration students. Students
should be familiar with common network and system administration tasks.
Previous bash shell scripting is helpful but not required.

Learning Outcomes
KNOWLEDGE

e DPerl syntax and constructs
e Important Perl modules
e Amazon EC2 cloud computing and VM management

e Creating plots, web pages and documents using retrieve data

SKILLS

e Write strict-compliant Perl scripts
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e Retrieve information from a variety of sources

e Numerically analyze retrieved data

e Create plots with Perl and gnuplot

e Create HTML and LATEX documents with Perl

e Interact with LDAP via Perl

e Use the Amazon EC2 cloud

e Script Amazon EC2 operations using Perl

e Automating common network and system administration tasks via Perl
scripts

GENERAL QUALIFICATIONS
e Ability to create Petl scripts to perform network and system administration
tasks

e Tamiliarity with cloud computing in the Amazon EC2 environment

Organization and working methods

The course will meet in one long block each week. Lectures with demonstrations
will be held during the first part of the class. The second part will function as a
lab session during which students will work on assignments with instructor

assistance.

Required course work
An assignment will be given every 2 weeks. One longer project will be assigned
during the second half of the course.

Form of assessment
Long project: 50%
Final examination: 50%

3.4.6 ADVANCED NETWORKING

Basic Information

Name of the course: Advanced networking

Level: Advanced

ECTS-equivalent credits: 10

Semester: 3

Evaluation method: Numeric grades 0-100 (50 is passing)
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Target Group
This course is designed to teach advanced networking concepts in great depth.
Students should have a good understanding and experience of basic networking

concepts, services and protocols.

Learning Outcomes
KNOWLEDGE

e Low-level networking and networking devices

e TCP/IP protocols and setvices

e [Pv6 networking

¢ Routing and routing protocols (including RIP, EIGRP, OSPF, BGP)
e Multicasting

e Quality of service (QoS) and traffic engineering

e IPsec-based security

e Wireless networking

SKILLS

e Configuring routing in a variety of ways
e Migrating from IPv4 to IPv6

e Managing and securing wireless networks

e Designing and implementing traffic flow using QoS

GENERAL QUALIFICATIONS

e Deep understand of networking at all levels

e Ability to select, install and configure appropriate hardware and protocols to
implement networking requirements in a variety of environments

Organization and working methods
Lectures with demonstrations will be held twice a week.

Required course work
Weekly assignments.

Form of assessment
Assignments 25%
Midterm examination 25%
Final examination 50%
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3.47 NETWORKINFRASTRUCTURE AND SECURITY LAB

Basic Information

Name of the course: Network infrastructure and security lab
Level: Advanced

ECTS-equivalent credits: 15

Semestet:

Evaluation method: Numeric grades 0-100 (50 is passing)

Target Group

This course is designed for second year students in the master’s in network and
system administration program. Students should be familiar with a range of
network and system administration tasks (as covered in Network and system
administration 1 and 2). They must be fluent in Perl scripting (or another
scripting language), and be familiar with virtualization.

This course is designed to prepare students for their thesis project work in
the fourth semester.

Learning Outcomes
KNOWLEDGE

e The scientific method and experimental design

e Statistical analysis of data, including confidence intervals

e Problems and approaches in network and system administration research and
testing

e Data analysis and reporting

SKILLS

e Designing and carrying out experiments

e Using analysis and benchmarking software
e Capturing data

e Analyzing data and making conclusions

® Preparing reports

GENERAL QUALIFICATIONS
e Ability to perform systematic comparison of hardware and software
approaches and implementations

e Prepared to plan and complete a master’s thesis project

Organization and working methods
Lectures weekly or biweekly.
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Required course work

3 experiments of a comparative nature chosen from a list of possibilities or by
the student him/herself. Each student will also give a presentation on one of the
projects.

Form of assessment
Each project is 33% of the final grade

3.4.8 WRITING THE RESEARCH PAPER

Basic Information

Name of the course: Writing the research paper

Level: Intermediate

ECTS-equivalent credits: 5

Semester: 3

Evaluation method: Numeric grades 0-100 (50 is passing)

Target Group

This course is designed for students in the network and system administration
master’s program. It covers searching for and understanding published works in
network and system administration.

Learning Outcomes
KNOWLEDGE

e Techniques for locating publications in network and system administration
e Focusing search results for the problem at hand
¢ Reading and interpreting technical publications

e Presenting published research in oral presentations and written reports

SKILLS
e Ability to search for and identify relevant research on network and system
administration topics

e Ability to summarize previous research in an area, orally and in writing

e Familiarity with the LATEX publication system

GENERAL QUALIFICATIONS
e DPrepared to carry out the background research necessary for the thesis

project and to summarize the relevant points in writing

Organization and working methods

The course will be a combination of lectures and student presentations.
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Required course work
3 short presentations (5-10 minutes) describing published research, along with a
paper of 15-20 pages

Form of assessment
Each oral presentation is worth 20% of the final grade
The research paper is worth 40% of the final grade

3.5 EVALUATION OF STUDENTS

Evaluation of students is important factor in increasing the efficiency of students
for their studies. They should be evaluated in such a way that they must perform
in the given tasks and also should not be a hassle for them. This can be achieved
by dividing the final grades on whole semester including assignments, midterm

exams and final exams.

For non-project courses, grades should be divided in the following way:

Assignments = 25% of the final grade
Midterm Exam=25% of the final grade
Final Exam=50% of the final grade

For courses having midterm examinations, this exam will be home-based,
meaning that students will be given the problem and have a given amount of
time to work on it, either at home, in the computing lab or wherever it is
convenience. Students will be permitted to consult with one another on this

exam, but each student must submit his/her own exam.

Some of the courses which are project based will be evaluated entirely on the
quality of the project(s).

3.6 AVAILABILITY OF FACULTY

Managing a master’s degree in network and system administration at the institute
level requires quite bigger vision of the said field. Moreover, there is a need of
proper technical people who can assist students properly in their difficulties
during study period. Having some experience with Pakistan’s educational system,
I know that it might be quite hard to find someone who can facilitate the faculty
to conduct such a degree program. However, there are individuals with fewer
technical skills who can nevertheless teach different courses of the degree
program. An educational institute interested in offering such degree can hire
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them and train them according to the demands of the courses. Some of the
courses can be found locally in Pakistan for training purpose, and some of them
can be arranged in foreign countries. However there will be a need of at least two
professionals who have master’s degrees in network and system administration
from well reputed institutes of the world.
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Chapter 4

Computing resources and strategies

This program includes a lot of hands-on work by students. The overall strategy is
that students can perform these tasks on virtual machines made through some
virtualization technology. If students wish to use their own laptops, this can be
achieved by using VirtualBox [18], an open source virtualization product.
Otherwise, they will use systems in the computing laboratory. In some cases, they
will also use resources in the Amazon EC2 cloud.

41 COMPUTING REQUIREMENTS

NSA studies require servers and other dedicated machines for students’ projects
and assignments in addition to ones in the common computer lab. As an
example, we will consider the intrusion detection and prevention systems labs in
the Intrusion detection and firewalls course. They require many virtual machines
where students can perform their lab work to get hands-on experience in a
realistic scenario. In a class of 30 students, each one needs to have 5 virtual
machines to carry on with the course work. A student will be given a network of
5 virtual machines according to the topology in Figure 4.1.

As we calculate the required number of VMs for 30 numbers of students
then it will cost us 150 VMs required to allocate the students or 75 virtual
machines if administration wants students to wotk in teams of two. Therefore, a
server that can support our requirements is needed, as well as another server for
backup in case of recovery or fault.
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Figure 4.1. Typical student virtual network

There are also server machines required for administrative usage, and
workstations needed for students for their course work and projects to be done
during studies. There is also a network lab equipped with routers, switches and
PCs to do the network-related assignments and projects. The networking
infrastructure requires routers, switches, PCs, cabling, and WiFi APs and
repeaters. Printers and other peripherals are also required. These requirements
are summarized in the following table:
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Table 4.1. Summary of Computing Resource Requirements

Resources | Quantity | Specifications
STUDENT LAB
Servers 2 Processor: 64-bit Intel or AMD, 4 or 8
cores
RAM: 320 GB (DDR3)
Disk: 4TB, 10K and 15K RPM Serial
Attached SCSI (SAS) drives
Raspberry Pi 30 Model B with cases
LCD monitors 30 HDMI support
SAN system 10 TB | 1 iSCSI SAN
NETWORK LAB
Routers 10 Cisco 7200 Series Routers
Switches 10 Cisco Catalyst 3550 Series Switches
WiFi Access Points | As needed | Linksys RE1000
Cabling As needed | RJ45 STP Cabling

ADMINISTRATIVE SERVERS/BACKUP

Servers

10

Processor: Intel® Xeon® processor E5-
2600

Ram: 8 GB (DDR3)

Disk: 1 TB Integrated Serial ATA
(SATA)/Serial Attached SCSI (SAS)

controller.

SAN Disk 10 TB

iSCSI SAN

NETWORK HARDWARE FOR WHOLE FACULTY

Routers 2 Cisco 7200 Series Routers

Switches 5 Cisco Catalyst 3550 Series Switches

WiFi Access Points | As needed | Linksys RE1000

Cabling As needed | RJ45 STP Cabling

ADDITIONAL RESOURCES

Printers 2 Heavy duty Network printers

Printers standalone | 5 Faculty support printers

UPS 1/Rack Server rooms power requirements (up to
5KW)

Generator 1 10 KW output capacity

Internet connectivity Redundant connectivity.
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Figure 4.2 illustrates these resources in place.

(etanialnle

Virtualization

Internet

Figure 4.2. Computing resources for the NSA master’s program

4.2 USING MLN TO MANAGE STUDENT
ENVIRONMENTS

Creating many VMs by hand is both tedious and time consuming. It is necessary
to automate this process in some way. The Manage Large Networks (MLN) tool
can help with this process.

MLN is a program written in Perl to create a Xen, User Mode Linux (UML)
or other virtualized systems by using a simple configuration file. It creates virtual
machines on demand and automatically, and makes configuration and
management simple. MLLN also provides virtual networks, and those networks
can be connected with each other if desired to make a larger network.

Using MLN, one can create an environment for virtualization using either
UML or Xen. The different characteristics of UML and XEN are compared in
Figure 4.3.
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Software Virtulization Operating
Technologies System

Standalone MLN UML
min setup
Xenify Scripy MLN UML || XEN
Customized Ubuntu
Ubuntu Install MLN umL XEN Dapper LVm
cD

Installation process to setup min

Figure 4.3. Comparing UML and Xen with MLN

The first task is to install MLN itself. A modified ISO of a Ubuntu Dapper
distribution installation CD and available online. This allows you to install and
prepare MLN environment quickly. However one may find issues related to
updating or installing programs later as this is an older version of Ubuntu. One
can also manually set up MLN.

MLN requires the following packages be already installed in order to

work:

e Perl: MLN is written in Perl. MLN also includes plugins to configure virtual
machines in many ways ,and those plugins are are written in. Therefore, one
needs to install Perl.

e UML or Xen: The desired virtualization environment must be installed.

e bridge-utils: Hosted virtual machines communicate through bridges.
Therefore, one need the bridge-utils package, which contains a utility to
create and manage bridge devices.

e screen: Screen is a program that enables users to emulate multiple console
“windows.” One can use some keystrokes to create new windows and switch
between them. It is a convenient interface to virtual machines, and MLN
supports it. It is optional, however.

e sudo: sudo is a program that allows a user/process to have root privilege for

one command.

Choosing between UML and Xen must also be done. UML is a specialized
Linux kernel which runs as binary. It usually does not require root access to run
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making it more flexible. But performance-wise, it is slower when compare dwith
XEN.

XEN is a virtualization platform which can support VMs running many
different operating systems. Performance-wise XEN is more efficient than UML.
However, it requires root access and is a bit more complicated

Xen seems to be the best to use in this scenario where our network topology
for intrusion detection and prevention systems needs to have different operating
systems such as Linux and Windows.

In this thesis, the modified Ubuntu Dapper ISO was used to install the server
operating system with Xen and MLN.

4.21 CONFIGURING MLN PROJECTS

A project can be created using MLLN programming language in which one write
correct syntax to create multiple virtual machines along with single or multiple
Ethernet switches. Below is a very simple example project file in which the
project nsathesis has three virtual machines, named gateway, apache and dns.
There is one switch to which all the three virtual machines are connected, named

vmbr(.

1 global {

2 project nsathesis
3 }

4 switch vmbr0o { }
5

6 host gateway

7 network etho {
8 switch vmbro0
9 }

10 }

1 host apache {

12 network etho {
13 switch vmbro0
14 }

15 }

16 host dns {

17 network eth0 ({
18 switch vmbro0
19 }

20 }

The following example MLN project file shows some of the features
available when creating a Xen VM:
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1 global {

2 project xenvm

3 }

4

5 host example {

6 xen # make Xen VM

7 memory 128M # RAM

8 template ubuntu-server.ext3 # OS image

9 size 2GB # virt. disk size
10 nameserver 10.0.0.100 # networking

11 network etho {

12 address 10.0.0.2

13 netmask 255.255.255.0

14 gateway 10.0.0.1

15 }

16 users { # add user & pwd.
17 athar encoded-password

18 }

19 }

This file defines the virtual machine’s specification and initial configuration
like memory allocation, OS image file, switch, host IP address, nameserver, and

SO Oon.

MLN offers superclasses and variables to make defining multiple VMs easy.
They also help to keep the information regarding VMs consistent. Superclasses
and Variables

Here is an example using a variable to define the IP address of the DNS

server:

1 global {

2 project nsathesis

3 $dns_address = 10.0.0.100
4 }

5 host dns {

6 network eth0

7 address $dns_address
8 1

9 }

10 host gateway {

11 name server $dns_address
12

13 }

The following project file shows the use of superclasses to define many hosts
casily:
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1 global {

2 project ids

3 $sanserver = 10.0.0.200
4 $externip = 192.168.24
5 $vncpasswd = encoded-password
6 }

7

8 superclass common {

9 xen

10 iscsi $sanserver

11 users {

12 athar encoded-password

13 }

14 size 4000M

15 memory 1024M

16 }

17

18 superclass sclin {

19 superclass common

20 template linux ids.ext3
21 root_passwd encoded-password
22 }

23

24 superclass scwin {

25 superclass common

26 template winXP_ids.ntfs
27 vncpasswd $vncpasswd

28 }

29

30 host win

31 superclass scwin

32 vncdisplay 7000

33 size 6000M

34 network etho

35 switch lan

36 netmask 255.255.255.0
37 }

38 winconfig {

39 users {

40 student $vncpasswd
41 }

42 }

43 }

44

45 host gwhost

46 superclass sclin

47 size 10000M

48 memory 2048M

49 network eth0

50

# external IP prefix

# settings for all VMs

# virt. disk on SAN

# Linux VMs settings

# Windows VMs settings

# Windows VM

# Add Windows user

# 1st Linux VM: gateway
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50 address 10.0.0.1

51 switch lan

52 }

53 network ethl # 2nd network interface
54 address ${externip}.50

55 netmask 255.255.255.0

56 gateway ${externip}.1

57 }

58 nameserver ${externip}.100

59 }

60

61 host linuxl { # 2nd Linux VM
62 superclass sclin

63 network etho

64 address 10.0.0.3

65 netmask 255.255.255.0

66 gateway 10.0.0.1

67 }

68 }

69

70 host linux2 { # 3rd Linux VM
71 superclass sclin

72 network etho

73 address 10.0.0.4

74 netmask 255.255.255.0

75 gateway 10.0.0.1

76 }

77 }

78

79 switch lan { } # Virtual LAN

This project also uses variables to simplify configuration.

4.3 RASPBERRY PI USABILITY TESTS

The Raspberry Pi was developed by members of computer laboratory at the
Cambridge University in 2000. They had found trouble while educating new
students. New students do not have such programming skills as they had a
decade before. In 2012, the foundation's work came to realization.

Linux was chosen as the operating system because of low memory overhead,
making it possible to run in such a simple device that does not have built-in
nonvolatile memory. Linux is also generally free and has great potential as a
teaching tool. Distributions often come with a programming language already
installed.
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In many places in the world, computers are not readily available, as they are
in most industrialized countries, and electricity is expensive. Cheap computing
for all can allow more people to be involved in computer science all over the

wortld, and also lead to useful innovations.

For this master’s program, the Raspberry Pi offers a very low cost way to
provide students with workstations. Some tasks can be performed on the
Raspberry Pi system itself, and it can also be used to connect to VMs on a server.

The systems in the system administration lab do not have any displays
attached. The systems are accessible only over a network. One can access only
using command line-based means (SSH and shells) or VNC.

Moreover most of the system administration tasks that student need to
petform can be done with the Raspberry Pi efficiently as there is no lot of
processing needed to access the remote machines. Therefore, the Raspberry Pi
has the strength to replace the expensive machines usually placed in labs as end
user machines to perform tasks. Simply students can have the Raspberry Pi in
their pockets to connect to network and display.

Command line based access via a Raspberry Pi system will work well. There
is some question about graphical performance, however. In order to test if the
Raspberry Pi will provide acceptable performance for VNC, several experiments
were done which performed a task on the Raspberry Pi and on a PC laptop. The
PC laptop has 2 GB of RAM and runs Windows (referred to as “PC”).

The following are the different experiment that were conducted:

e Manipulating an image with GIMP. 3 different file sizes were used.
e Adding new users to LDAP using the phpldapadmin web-based tool.
e  Working on OTRS to issue tickets to customers.

e Streaming video from the Internet in a browser.

All tests were done via a VNC connection to a VM on the server. These tasks
were chosen to be as graphically intensive as possible in order to stress the
Raspberry Pi.

4.3.1 IMAGE MANIPULATION TESTS

GIMP is the GNU Image Manipulation Program. It is an open source
program to perform different task related to images. The GIMP software is
hosted on a virtual machine with 1 GB RAM. Experiments have been completed
on the Raspberry Pi and PC according to procedure summarized below. This
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procedure is repeated for 3 sizes of image files: smalljpg, medium.jpg and

large.jpg. The image characteristics are listed below:

File size | Expanded | Dimensions | Dimensions | Resolution
Image file (MB) size (MB) (cm) (pixels) (dpi)
small.jpg 4 11.4 25x11 3000x1333 300
medium.jpg 11 47.4 50x22 6000x2760 300
large.jpg 17 137.3 82.5x40 9900x4849 300

Test procedure:
Make a VNC connection to the VM installed with GIMP.
Open GIMP before beginning.

Repeat 20 times:

Start timing.

1. Open the test file (File->Open).

2. Choose Image->Transform->Flip horizontally

3. Choose Filter->Distorts->Mosaic. Click OK in the next dialog.

4. Choose Filter->Distorts->Page Cutl. Click OK in the next dialog.

5. Choose View->Zoom->200%
6. Choose File->Close.
7. Choose File->Open and select roses.jpg.

Stop timing when roses image appears.

Time is measured in seconds using a stopwatch.

Figure 4.4 shows part of the test procedure in progress.

)
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Figure 4.4. Running gimp over VNC connection to host Ubuntu Server

53



RASPBERRY PI USABILITY TESTS

Figure 4.5 shows the results of the tests for the small image size.

Image manipulation test (small file)
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Figure 4.5. Results for image manipulation test (small file size)

It has been observed that there is a slight difference of time between
Raspberry Pi and PC to complete the experiment. There were 20 experimetns
conducted. Data is collected in terms of seconds, their mean value and standard
devitation value is calculated to analyze further. The mean value for the
completion of an experiment is 17.55 seconds and 21.3 seconds on PC and
Raspberry Raspberry Raspberry Pi, respectively (standard deviation 0.9 and 1.2).
PC performed experiments with faster response time, but Raspberry Pi also gave

a satisfactory response time.

Figure 4.6 shows the results for the experiments for the medium size picture.
is conducted and data is collected in seconds. The Mean and standard deviation is
calculated both for PC and Raspberry Pi. PC has a mean value of 43 seconds and
Raspberry Pi has a mean value of 48.45 seconds. The standard deviations are 1.2
and 1.8 seconds, respectively.. Again it is noted that PC is comparatively faster
than Raspberry Pi but the difference is not so big that someone can rule out
using Raspberry Pi for working in graphical environment.
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Image manipulation test (medium file)
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Figure 4.6. Results for image manipulation test (medium file size)
Image manipulation test (large file)
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Figure 4.7. Results for image manipulation test (large file size)

Figure 4.7 shows the results for the large size image. The third experiment

took quite a bit longer time than the previous experiments to complete. It shows

the similar results to the previous two experiments. PC completed its

experiments with a mean value of 253.6 seconds, and Raspberry Pi did so with a

mean value of 271.4 seconds. Standard deviation values are quite close for both
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Raspberry Pi and PC: 4.1 and 5.0 seconds, respectively. Once again, the
Raspberry Pi performs almost as well as the PC.

4.3.2 ADDING USERS TO LDAP

LDAP Lightweight Directory Access Protocol is an application protocol for
accessing and maintaining distributed directory information services over an IP
network. System administrators have to use it frequently throughout their career.
It is installed and configured on a machine and can be accessed in a graphical
environment using phpldapadmin (illustrated in Figure 4.8). The graphical

environment can be accessed through the web using a browser.

This experiment is designed in such a way that LDAP and phpldapadmin are
installed and configured a virtual machine with 1GB RAM. Phpldapadmin is
accessed via browser on both PC and Raspberry Pi. Users have been added 20
times and the elapsed time is noted for both computers.

“Moap
=admin 1T ¥8@

Home | Purge caches | Show Cache

Create Object

Templates: 0%

‘i Samba: Group Mapping
! Samba: Machine
o
o
o
o
o=
o
Q Thunderzed: Address Book Entry

B xolab: User Entry v, User Group

R samba: Account i Defauilt

Figure 4.8. The phpLDAPadmin LDAP administration tool

There is negligible difference noted for the elapsed time between PC and
Raspberry Pi. Mostly, they have the same response time or a slight difference of
one second, which is quite difficult to measure. PC has the 1.7 seconds as its
mean value and Raspberry Pi has 2.4 seconds. This is such not a considerable
difference that one would prefer using a standalone PC over Raspberry Pi to do
similar transactions through a web browser.
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LDPA server interface test
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Figure 4.9. Results for LDAP and OTRS web-based administration tests

Also there is negligible difference noted in standard deviation values (about
0.5 seconds for both). The standard deviation values are large compared to the
data values, but this is due to the short duration of the test and the difficulty in
measuring the elapsed time. Therefore we can say that PC and Raspberry Pi work
the same with respect to graphical web interfaces.
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4.3.3 USING OTRSTO ISSUE TICKETS

OTRS is the Open Source Ticket Request System used to resolve different
queries regarding customers (see Figure 4.10). It has many features which help
system administrators and business managers to manage customer telephone calls
and e-mails. An experiment is designed and OTRS is installed on one of the
virtual machine with 1GB RAM. An SMTP server is also set up to handle emails
while issuing tickets.

After installation of OTRS on the VM, a web browser is used to configure OTRS
and access the main page. After successful configuration, a ticket is issued to one
of the user and the time is noted to complete the process of the ticket issuing
query. There were 20 experiments conducted, and the data was collected. These
operations were also very rapid and showed the same pattern as the LDAP user

add operations. The mean was 1.3 and 2.2 seconds for PC and PI, respectively
(standard deviations 0.4 seconds for both).

root@iocalhost
root

(lengoy))
Your OTRS Team

Top of page O

Figure 4.10. OTRS software

Figure 4.11 shows the mean results for all of these tests. The error bars are
two times the standard deviation. The results for the web administration interface
tests are multiplied by 10 to make it easier to plot all tests together. A logarithmic
scale is used for the Y axis for the same reason. The graph shows that there is
only a small difference between the Raspberry Pi and the PC.
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Mean performance results: PC vs. Pi
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Figure 4.11. Results for all tests

Figure 4.12 plots the performance penalty for the Raspberry Pi for each test,
as a percentage of the elapsed time on the PC. Most of the values are quite small.
The largest values are for the web interface tests, for which the elapsed time is

tiny anyway.
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Raspberry Pi Performance Penalty
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Figure 4.12. Raspberry Pi performance penalties vs. PC

4.3.4 STREAMING VIDEO TEST

In previous experiments, it has been noticed that there is a negligible or only a
slight difference between PC and Raspberry Pi. There is a need to find a task
where one can see a considerable difference between Raspberry Pi and PC.
Therefore, an experiment of streaming video is designed and performed to find
out if Raspberry Pi can handle processing like PC does.

A video file is hosted on a virtual machine installed with an OS Ubuntu 12.10
Server. Mplayer is an application which plays the video on Linux based systems.
A VNC connections is establish in different time slots from Raspberry Pi and PC
to the VM hosting the movie. The movie is played, and it is streamed through
VNC connection towards the Raspberry Pi and PC.

This experiment saturated the resources of Raspberry Pi and a clear
difference has been seen between the Raspberry Pi and PC. During the
experiment, memory and CPU usage are also monitored to find the cause of
difference noted in experiments.

top - 16:47:01 up 59 min, 3 users, 1load average: 1.13, 0.68, 0.43

[Tasks: 124 tocal, 2 running, 122 sleeping, 0 sctopped, 0 zombie
WCpu(s): 64.1 us, 22.5 :ly,l 0.0 ni, 0.0 id, 0.0 wa, ©O0.0 hi, 13.3 si, 0 (
KiB Mem: 448996 total, 198024 used, 250972 free, 14832 buffers
[KAB Swap: 102396 total, 0 used, 102396 free, 67368 cached

RT RE SYR 5 3CFU IMEM

84 4128 1920 R_50.2 0.9 0:30.
Figure 4.13. Raspberry Pi performance data during streaming video test
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RASPBERRY PI USABILITY TESTS

As it can be seen clearly in Figure 4.13, the Raspberry Pi can only use 50% of
CPU. The rest of CPU usage is consumed keeping by the OS. Other setvices,
such as xdesktop, are also consuming the processing resource. Therefore, clear
distortion is noticed when displaying streaming data on the Raspberry Pi.

CPU Usage CPU Usage History

Memory Physical Memory Usage History

Figure 4.14. PC CPU and memory stats during streaming video test

In contrast, on PC the video plays propetly. No distortion or delays were
observed throughout the experiment. Figure 4.14 shows that PC has enough
processing resource to handle the VNC process efficiently.

Based on these results, one can say that the Raspberty Pi is not efficient for
VNC operations requiring significant local processing. This is not surprising
considering its specifications.
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Chapter 5

Facilities and finances

This chapter discusses the physical building and power requirements for the
proposed master’s degree program in network and system administration. It also
considers connectivity issues.

51 CLASSROOM AND LAB SPACE

A network and system administration program is a quite resource demanding
program of study. It requires planned facilities so that students can have a perfect
study environment during their studies. In general, the building for a faculty of
computer sciences can accommodate this program along with other courses
being taught already.

However, NSA studies require additional facilities for conducting lab tasks.
Most of the course work is practical lab work. Therefore, some extra steps need
to be taken to setup such an environment that students can perform their tasks
propetly. This requires proper lecture and lab rooms.

The study environment for the students will be mostly practical-oriented.
Therefore it would be a requirement to have such a lecture room where one can
have access to lab computers as well. At least two lecture rooms along with lab
computers need to be arranged for initiating this scheme of study. Generally such
facility can be arranged easily in an institute where there are already computer
sciences studies in progress. The same computer lab can be used as for other

courses related to computer sciences.

In addition to this, the networking part of Network and system
administration 1 and the Advanced networking course need a completely
different environment besides computer lab. These courses require some
equipment related to layer 2 and layer 3 of an OSI model, the data link layer and
network layer, respectively. Switches are used for LAN to handle data link layer
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traffic, while routers are used to handle network layer traffic. Therefore, an extra
room is required to make a lab environment where routers and switches will be
placed for the lab work in this course.

Many courses, including the Intrusion detection and firewalls course, require
some server machines in many virtual machines will be given to students to work
on. Those servers can be placed in another separate room or in a room already

used for placing servers providing services to students or faculty.

The Network and system administration 2 course’s lab work requires separate
machines for each student with good specifications. Those machines will be
placed in a separate room where students will be given controlled access to work
on those machines. Those machines can be remotely accessed once they are
configured propetly, and most of the tasks will be performed remotely.

Furthermore, it would be good idea to arrange for a quiet study room where
students can sit and work on their studies without any interference. There should
be also a social room for students where they can share ideas and do combined
work when appropriate.

Figure 5.1 provides a diagram depicting the building requirement needed for
the students to carry on studies in network and system administration.

The rooms need to be well furnished according to the requirements of that
room. Proper sittings, computer desks, racks for server rooms and connectivity
are the main furnishing requirements for initiating the network and system
administration program.

52 POWER

Network and system administration studies are 100% dependent on electric
power. There will be equipment like personal computers, servers, routers,
switches and multimedia that need power to run on. Currently Pakistan is facing
a shortage of 4000-10000 MW of electricity. There is a demand of 17000 MW of
electricity currently, whereas the production fluctuates between 7000 MW and
13000 MW depending on how much water is available in dams and the capacities
of any alternative energy resources.
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AD AL

Students
Machines

Building requirements for the Network and System administration studies.

Figure 5.1. Facilities for the NSA program

Masses suffer as power shortfall exceeds 6,000MW
ast Updated On 18 May,2013 About 29 minutes ago H J B

=< 3&’?-_

The citizens have expressed over the prolonged power outag

Figure 5.2. Headline related to power problems in Pakistan
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Because of this, the masses are suffering, and even educational institutes are
not exempted from power outages. Since Pakistan is a country facing a huge
problem regarding its electricity demand, therefore one must focus on planning
for the power needed for all the equipment to run all of the time. Therefore,
UPC devices are needed to handle the intermittent short power outages, and a

generator is necessary for the longer power outages.

5.3 CONNECTIVITY

Network and system administration studies are all about connectivity and
services. From the first day, students need to connect to their virtual machines,
from within the campus or from outside the campus remotely. Therefore, it will
be a requirement to build an internet infrastructure for this program that students
can start work on their study tasks without any problems in connectivity. For this

reason, redundant connections to the Internet are vital.

5.4 INVESTMENT AND FINANCE CONSIDERATIONS

The objective of providing a master’s degree program that brings innovation and
research at educational institutions in the country is strongly linked with the
investment made into the education sector. In this way, an institute can compete
and progress along with other well reputed institutes in the world. Network and
system administration studies are quite investment-demanding as there are many
resources needed to allocate to students. Students will progress through different
courses, and all of those courses need appropriate resources so that students can
petrform their lab work propetly and avail themselves of the opportunity for
hands-on experience in their respective studies.

Generally to start with such degree program one should consider a sizeable
investment for the required facilities:

¢ Building and furnishings

e Computing equipment: workstations, servers, networking, multimedia
e Power Backup

e Taculty Expense

e Maintenance and upgrades

e Professional memberships

There are different sets of rooms needed to initiate such degree program. It’s
the most important step to include it to the plan. There is need of lecture rooms,
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INVESTMENT AND FINANCE CONSIDERATIONS

faculty offices, system administration lab, networking lab and quiet room.
Altogether there is need of 15 rooms required according to the type and purpose

of room.
5.41 EQUIPMENT

Network and system administration studies are all about computer equipment.
This includes many things like PCs, servers, networking equipment, multimedia
equipment, power backup and so on. The estimated cost of the important
equipment required to initiate NSA studies is given in the following table:

Estimate

Resource Quantity (PKR)
Servers: coursework 2 1,200,000
Servers: administrative/backup 10 1,000,000
SAN 10 TB 2 2,000,000
Routers 12 1,100,000
Switches 15 1,000,000
Cabling As needed 100,000
WiFi Access Points As needed 500,000
Raspberry Pi with cases 30 260,000
PCs for NSA2 students 30 3,000,000
LCD Monitors 30 300,000
LCD TVs 4 140,000
Printers (network) 2 210,000
Printers standalone 5 100,000
UPS 1/Rack 5 300,000
Generator 1 225,000
Internet connectivity ISP 2 40,000
Other supplies As needed 100,000
Approximate total cost 11,575,000 PKR
~685,000 NOK

5.4.2 FACULTY

NSA studies need experienced and well trained professionals in the field of
Network and System Administration as its faculty members. One can start this
degree program with at least three professionals who are significantly skilled in
UNIX/Linux based systems, services and security. Moreover they also should
have hands on experience in advance networking course. There will be a need for
student assistants who can assist students when needed. Recruitment of staff also
requires a good budget according to current trends in the country. Furthermore,
all the expenses to keep faculty running also needed to be considered.
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5.4.3 MAINTENANCE AND UPGRADES

NSA studies require equipment maintenance and upgrading on an ongoing basis.
Replacement and upgrading of hardware equipment will be required as more and
more advanced technologies become available. Electrical equipment may stop
working and its maintenance and eventual replacement should be focused on

when considering the overall cost that this degree program requires.

Updates also occur on the software side. The program will need to update
their software which require licensing. For example, Snort is an important
intrusion prevention system which requires the latest snort rules to work
efficiently and make one’s network system secure. Snort is an open source tool,
but snort rules may need licensing. Also, in some cases proprietary solutions will
need to be purchased and licensed. All these things are part of overall costs when
planning to initiate degree program in network and system administration.

Sometimes, software updates will also require the latest hardware equipment.
For example, PROXMOX is an important tool for virtualization which only
supports 64 bit architecture processors. One would have to switch from 32-bit to
64-bit processing to use such a tool.

5.4.4 PROFESSIONAL MEMBERSHIPS

Studies in any discipline cannot be highly fruitful if teaching material and
technologies adopted are not up to date. There are many different organizations
throughout the world which conduct conferences and produce publications. One
can get benefit from such organizations. They often require membership to have
access to those conferences and the publications. The following are the two
organizations which are quite active in the field of computing and system
administration for UNIX-based operating systems:

e The USENIX Association came into being in 1973. Its focus is study and
development of UNIX-based computing. It has earned a good name and
held in high regard among the computer professionals, researchers,
developers and organizations who work on computer operating systems. It
publishes many journals and paper which are quite significant for the industry
and that institutes need in order to keep up with the latest work.

e LISA is a Special Interest Group of the USENIX Association. It holds
conferences and training for professionals. These introduce the latest tools,
techniques, information and services relevant to system administrators ot

organizations.
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Chapter 6

Conclusion and future work

This thesis has been carried out substantial analysis and practical work to explore
the possibility of initiating a master’s level program in network and system
administration in Pakistan. After a glance over my experience, I managed to write
such a document which can help out Pakistan’s needs in producing quality
network and system administrators. Recent technical education regarding NSA
has been evaluated and examined to find where there is a need of improvement.
After finding the current programs offered in educational institutes, it was
noticed that no NSA studies at master’s level is available in any educational
institute in Pakistan. Existing NSA programs have been also evaluated worldwide
to find out the mechanism to initiate similar type of studies in Pakistan. The
curriculum structure along with course descriptions is proposed in the thesis

work.

6.1 ANALYSIS AND FUTURE WORK

The technologies needed to set up the required lab environments have been
discussed. Computing resources and strategies along with their practical
demonstrations is presented in this thesis. Several experiments were performed
to find out the usability of a small credit card size computer named Raspberry Pi.
Tests to check VNC connection, interacting with web applications and streaming
video were carried out. It is found it is quite efficient in performing different
tasks related to network and system administration. Those experiments compared
a standalone PC to the Raspberry Pi, and the difference between them was
negligible. Therefore, the Raspberry Pi has shown its capability to assist NSA
students in performing their normal tasks in a graphical environment.

Unfortunately, only a single Raspberry Pi device was available for this
research/ There ate number of other experiments that can test more the
scalability of the Raspberry Pi in a realistic lab environment that should be
performed before a final decision is made.
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A lab design was present virtualization with the help of Xen and MLN.
Installation and configuration has been taken place. It was felt that installation
and configuration was quite exhausting some times as no online updates
regarding documentations and support is available for MLLN. Also, MLLN does
not completely support KVM, another virtualization solution for Linux is
becoming more popular and common than Xen. Therefore, future work should
involve MLN support for KVM.

Facilities and initial cost requirement were also considered. The cost
estimates will also need to be updated whenever a program is actually started.

Master studies in Network and System Administration has been evaluated to
initiate in Pakistan. This includes huge workout in managing all the things. It will
be crucial to note the number of students recruited in the beginning of studies
for the first time. There is possibility of frustration during this early time if there
are too many students at the same time when one needs to manage and
troubleshoot different labs and environments. Therefore it would be good to
start with limited number of students, and later on, after gaining a firm grip over
the management, one can increase the number of students.

This project is written with the consent to fulfill my rights over my country,
therefore it is intended to conduct seminars in different educational institutes and
governing bodies responsible for higher education in Pakistan. This has been
started while working on this thesis. Two seminars have been conducted in the
Government Post Graduate College Mandian Abbottabad and at Hazara
University Pakistan (see Figure 6.1). There was great enthusiasm from students
and faculty over bringing such studies of network and system administration into
Pakistan. I am quite confident I can bring it into life.

Figure 6.1 The author conducting a seminar at Hazara Univeristy
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Appendix A
MLN example

# mln register template -m "NSA template" /tmp/nsa_lin.ext3

Copying nsa_ lin.ext3

No need to extract.

# mln list templates
All available templates:

Name : Real name:
ubuntu-server.ext3 ubuntu-server-V0.1l.ext3
nsa_lin.ext3 nsa_lin.ext3
ubuntu-desktop.ext3 ubuntu-desktop-V0.1l.ext3
Debian-4.0.ext3 Debian-4.0-V1.0.ext3

# cd ../files/root

# cat nsa.mln

global {

project nsa

1

superclass common {
template nsa_ lin.ext3
nameserver 10.0.0.100

}
host gw {
superclass common
memory 1024
network etho
address 10.0.0.1
netmask 255.255.255.0
}
}

host client {
superclass common
memory 750M
template Debian-4.0-V1.0.ext3
network etho
address 10.0.0.2
netmask 255.255.255.0

}
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APPENDIX A

switch lan { }

# mln build -r -f nsa.mln
Service hosts:

-> Switch lan

Bridge: lan.nsa

Xen enabled

++ printing Superclasses ++
--> Superclass common
common: template = nsa lin.ext3
++ printing Hosts ++

--> Host client (XEN)

client: nameserver = '10.0.0.100'
client: superclass = 'common'
client: memory = '750M'

client: template = Debian-4.0-V1.0.ext3
printing network
client: Network interfaces
Interface etho
address: 10.0.0.2
netmask: 255.255.255.0
--> Host gw (XEN)

gw: nameserver = '10.0.0.100'
gw: superclass = 'common'
gw: memory = '1024M'

printing network
gw: Network interfaces
Interface etho
address: 10.0.0.1
netmask: 255.255.255.0
+---> BUILDING nsa
Saving Config file : /opt/mln/projects/root/nsa/nsa.mln
---> Building switch lan
---> Building XEN host client
Template size: 314574848
New size: 262144000
WARNING: Template is larger then new filesystem!
Adjusting size to fit template.
Filesystem size: 300M
Building filesystem: copying, growing, fsck, resize, done
---> Building XEN host gw
Template size: 471859200
New size: 262144000
WARNING: Template is larger then new filesystem!
Adjusting size to fit template.
Filesystem size: 450M
Building filesystem: copying, growing, fsck, resize, done
+---> STARTING VM FOR FILESYSTEM CONFIGURATION (1 of 1)
Service hosts:
---> Configuring XEN host client
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Adding interface etho

Importing modules from: /tmp/mln/modules/2.6.16-xen
---> Configuring XEN host gw

Adding interface etho

Importing modules from: /tmp/mln/modules/2.6.16-xen
+---> SHUTTING DOWN VIRTUAL MACHINE

+---> PROJECT nsa FINISHED

# mln status examplel

nsa host client down

nsa host gw down

nsa switch lan down

# mln start -p nsa

Setting up lan

Starting client.nsa in screen

Starting gw.nsa in screen
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